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Symbols used in this manual
The following symbols are used throughout this manual to indicate warnings
and cautions.

WARNING

Indicates a potentially hazardous situation which, if not avoided, could
result in death or serious injury.

WARNING

Indicates an electrical shock hazard which, if not avoided, could result in
death or serious injury.

CAUTION

Indicates a potentially hazardous situation which, if not avoided, could
result in minor or moderate injury; or alerts against unsafe practices; or
alerts against actions which could damage the product or result in a loss
of data.

CAUTION

The ESD susceptibility symbol indicates that handling or use of an item
may result in damage from ESD if proper precautions are not taken.

HINT/TIP

The info icon indicates sections which provide additional information about the
product. This information is not essential for correct operation of the instrument,
but provides knowledge to make better use of the instrument.
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1.2

Manual conventions

When the wording “Click Start ...” is used, this refers to the Windows® Start
button. Compared to Windows® XP, Windows® Vista and Windows® 7, the Start
Menu has undergone some significant changes. The taskbar icon is no longer
labeled "Start" and is now simply the pearl icon (of the window-frame in an orb).
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2 Introduction

21 BE3200 Test Sequencer Option in Perception
The Sequencer option enables you to communicate with and control the
BE3200 Sequencer. You can freely edit sequence start and stop times and
durations within the Sequencer sheet for ultimate control.

In this manual we will describe the additional tools and options that the
Sequencer sheet provides and how to use them.
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3 Installation

31 Requirements
e Perception software is installed
e one free COM port is available for communication with the BE3200

hardware.

311 System requirements
e TrueColor (24-bit) video display adapter with 64 MB on-board video
memory and hardware DirectX 9 support using a screen size of at least
1280 x 900 pixels, recommended 1600 x 1200.
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Software Installation

Installation of Sequencer option in Perception

The Perception software requires a HASP key. HASP (Hardware Against
Software Piracy) is a hardware-based (hardware key) software copy protection
system that prevents unauthorized use of software applications.

x__—-"
Figure 3.1: HASP key

Each HASP key contains a unique ID number used for personalization of the
application according to the features and options purchased. The key is also
used for storing licensing parameters, applications and customer-specific data.

If you have purchased the Sequencer option as a separate item, you will receive
a personalized "key file". Use this file to unlock the additional features.

You can find the serial number of your key in Help About Perception To
update the key information:

1 Choose Help » Update Key...
2 In the Open dialog locate the Key File (*.pKey) and click Open.
3 If everything is OK you will see the following message:

f =

Perception

-
1 / The software copy protection key is successfully updated.
=

[ ok ]

Figure 3.2: Software copy protection dialog

4 Click OK.
After the installation you can go to Help » About Perception » More... to see
all installed options

11
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3.2.2

You will need to restart the program before the changes take effect.The
Sequencer option is now available.

Serial communication port

The Sequencer option needs an unused COM port to communicate with the
BE3200. The Perception software will automatically scan all free ports for the
port to which the BE3200 is connected whenever you connect with the software
to the BE3200.

Scanning starts at the port which was last used. When the BE3200 is not
switched on and you try to connect to the BE3200, the software will report “No
BE3200 sequencer connected!”. Switch on the BE3200 and connect again.
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4 Getting Started

41

Note

A02702_01_E00_03 HBM: public

Initial check
Make sure the following is available:

e Perception Sequencer Option
e Communication link

At this point you can plug-in and power on your BE3200 Test Sequencer.

13
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4.2 Introduction to Terminology
Definitions
Within the Sequencer Option a number of concepts are defined which are
explained in this section.
Sequence
A sequence is defined as a number of timed actions to be performed within a
certain interval. A sequence has a start and a finish and can be regarded as
one integral undividable operation.
Duration
The time between the start and finish of the sequence is called the duration.
The duration of the sequence can be expressed in time, cycle:degrees or half
cycles.
Cycle:degree
The cycle:degree notation is derived from the cycles of a sine wave. The unit
is one cycle. One cycle of a sine wave is divided into 360 degrees.
Examples:
1:000 equals one cycle
2:180 equals two and a half cycle
Halfcycles
The halfcycle notation is derived from the cycles of a sine wave. The unit is half
a cycle. A halfcycle is divided into 100 parts.
Examples:
2.00 equals two halfcycles and equals one cycle:degrees (1:000)
4.10 equals 4 and 10/100 halfcycles which equals two cycles and 18
degrees (2:018)
Start and length
The moment a channel switches from the OFF state to the ON state is called
the start. The time a channel is ON is called the length. The start of a channel
is referred to the start of the sequence (t=0). There are three ways to specify
the length:
e Set the length by entering the required value
e Select the short-cut “to end” - of sequence-
e Select the short-cut “pulse”
14 A02702_01_E00_03 HBM: public
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The following Figure 4.1 shows the main parameters of an output channel’s
state:

SEQUENCE DURATION

| LENGTH |

-~ R IR B A
! T !

0 START END OF SEQUENCE

AR

Figure 4.1: Parameters of an output channel's state

Pulse length

For ease of use you can set a pulse length. When the short-cut “pulse” is used
to define the length of an ON-state in a channel, automatically this value is used
to set the length.

Main delay

The complete sequence (all output channels) can be delayed. This delay can
be set anywhere between 0 and 359 degrees of a cycle. Since a sequence is
synchronized (starts) with a zero-crossing of the synchronization source, this
effectively shifts the complete sequence away from the zero-crossing with the
specified amount of main delay.

o

0
SEQUENCE START—»
108 °

MAIN DELAY
Figure 4.2: Sequence main delay
Synchronization modes

Independent of the selected synchronization source, various synchronization
modes are available. These modes are:

15
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e Full
e Timed
e Measured
e None
Full synchronization
When full synchronization is selected, the BE3200 locks its internal timing to
the synchronization source and uses the synchronization source during the
complete sequence to verify its timing. This is depicted in the following
Figure 4.3.
LOCK SYNCED
N L
L SEQUENCE |
T < >
START
Figure 4.3: Full synchronization
The sequence starts at a zero index pulse.
Timed synchronization
When timed synchronization is selected, the BE3200 locks its internal timing to
the synchronization source and verifies its internal timing with the
synchronization source only for a specified time interval from the actual start of
the sequence as shown in the following Figure 4.4.
LOCK SYNCED “FREE” RUN
| >
4 L
L SEQUENCE |
T < >
START
Figure 4.4: Timed synchronization
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When the specified time has elapsed, the BE3200 continues to operate with
the last measured synchronization values.

The sequence starts at a zero index pulse.

Measured synchronization

When measured synchronization is selected, the BE3200 locks its internal
timing to the selected synchronization source. At the start of the sequence the
BE3200 continues to operate with the last measured synchronization values.
The sequence starts at a zero index pulse.

LOCK “FREE” RUN

SEQUENCE

START

Figure 4.5: Measured synchronization

No synchronization
When “none” is selected as synchronization mode, the BE3200 uses the
parameters as set by the software for its internal timing.

The start of the sequence is after receipt of a start command.

Additional synchronization parameters

Clocks per cycle

The number of clock pulses per cycle can be set. This parameter is used to
verify the clocks per cycle of the generators 1 and 2 with clock and zero as the
synchronization source is selected. When the set number of clocks per cycle
does not match the measured clocks per cycle, an error is generated.

Frequency

The frequency can be set. This parameter is used to verify the frequency of the
synchronization source. When the set nominal frequency - plus or minus the
set maximum deviation does - not match the measured frequency, an error is
generated.

17
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Note This frequency is also used to calculate the correct number of cycle:degrees
for the correction factor, main delay and when no sync mode is selected. It is
also required for a correct conversion between milliseconds and cycles.
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4.31

Introduction to the Sequencer Option

Start the software

Once you start Perception and the Sequencer option is installed you should be
able to see a new tab available in the tabbed sheet bar.

& Sequencer

If you select the Sequencer tab the Sequencer sheet should come up as shown
in the following Figure 4.6.
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Figure 4.6: Sequencer Sheet
Sequencer Tab

Task Pane

Groups - (Status group)
Channel Options Pane

Display Area

Mmoo W >

X-Axis Annotation
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A Sequencer Tab
Click The Sequencer tab to bring the Sequencer sheet on top.

Sequencer Sheet:

This Sheet contains all the main data and information on the pulses
and channels; including state of activation, whether the channel is
active or locked, the name of the channel and its corresponding
optional label.

Channel names:

Text strings are assigned to a channel, they can be changed at any
time and are any length however only a certain amount of characters
can be visually displayed under the channel name.

A02702_01_E00_03 HBM: public
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B The Task pane contains the following groups:

B —eview a

Status group
View group
Pulse group

Status details group

m oo w >

User Keys group

A02702_01_E00_03 HBM: public 21
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C Groups
The Status group Shows the main Sequence controls and displays

Status X
System:
Standby

Frequency:

Run

| Include acquisition

The displays show the system status (offline, configuring, standby or
running) and the measured frequency of the synchronization source. It
also shows the progress of an operation controlled by this group. The
control box allows you to connect or disconnect to the BE3200 and to
run a sequence once connected. There is also a check box to include an
acquisition.

System Status:

e Offline No connection or communication with hardware available. This
can be true when a sequence is created or modified without connected
hardware.

e Standby Sequencer hardware is online, i.e. there is communication
with the hardware. Setting modifications will be sent immediately to
the hardware.

Running The hardware is busy executing a sequence.

Waiting When the software has been set up to execute more than one
sequence (repeat mode enabled) this status is shown between
consecutive tests. In the last 30 seconds between two tests the
message is replaced by a down count of one count per second.

The measured frequency display shows the actual measured frequency
of the selected synchronization source.

A02702_01_E00_03 HBM: public
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View group Provides a way to easily change between the timing units
used in Sequencer.

View a

(2] 2]=)

Figure 4.7: View group

Pulse group Shows your interactive channel and pulse information. You
can also delete and create new pulses from this panel.

. Pulse (cyc:deg) ~
Channel: Pulse:
th2s = oo B a
Start Length

New pulse at cursor

Figure 4.8: Pulse group

Channel name is the text string in the Channel field.

Pulse Shows the current pulse number out of the total number of
pulses in a channel.

Phase ©' Is the phase of a selected pulse in that channel.

Start time indicates the start time of the selected pulse in the output
channel.

e Length of pulse indicates how long the selected pulse will remain in
the On-state.
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Status details group

Status details a

Main delay:

Restart:

Figure 4.9: Status group

e Main delay Shows the main delay in the units selected (for the
complete sequence).
Restart Shows the current sequence restart status.
Synchronization Shows the current mode of synchronization.

The User Keys group can be used to configure User Keys. See
Perception User Manual for details on User Keys in general and
Sequencer specific User Keys.

User Keys 2

[E]_

Figure 4.10: User Keys group
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5 Control and Usage

5.1

A02702_01_E00_03 HBM: public

Introduction

For control of the BE3200 the Sequencer Option is provided. You are provided
with 128 channels to work with and a variety of options which are described in
the following section.

This chapter will guide you through the various steps, required to obtain a
general understanding of the concepts used in the Sequencer Option and an
introduction to the contents of the Sequencer Option sheet.

25
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5.2 Using the Sequencer option
The following highlights the main areas for con

G
s — § CTl handle

JeaBdA ! = B &

trol of the Sequencer option.

Ui duaudeaauuoad s

|
LSENENENERENERE RN

L]
i
I & g P
i % [
» * B
ClAdiula il iu i e

Figure 5.1: Sequencer tab

Status group

Acquisiton contols

View group

Pulse group

Status group

User Keys group

CTI (Current time indicator) value
CTl handle

I O M mMmoOUO W >
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A Status group Select the task pane where the connect button is located.

At first the Run button should be greyed out. Click the connect button L
to start the communication link.

When connected you will be able to click the Run button.

The following will be displayed in the status pane.

>

Status

System:

Standby

Frequency:

Progress:

Control
&) ]

| Include acquisition

Figure 5.2: Status group

The system status should read Standby.

Note At this point at least the following indicators on the BE3200 front panel must be
on:

e Poweron
e Sequencer on line
e Communication OK

The measured frequency display shows the actual measured frequency
of the selected synchronization source.

A02702_01_E00_03 HBM: public 27
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B Acquisiton contols

Note Acaquisition controls are not part of the Sequencer option please refer to the
Perception User Manual for further information.

Acquisition Control 3 X

B Name

| Recording010 )

B Acquisition

Ready

TE [
'\J\‘:H > H = ‘13//‘
Preview Record Stop Trigger
b Status
e
Memory: [ o N
Disk: [—
Rate: I .
P Groupl
Continuous

Sample rate: 1@ kS/s -
Acg. mode: _Standard b J

10

Figure 5.3: Acquisition controls

Figure 5.3 includes controls which can also be used to control a sequence,
see additional information in chapter “Sequencer Run button vs.
Acquisition Start” on page 51.

28 A02702_01_E00_03 HBM: public



HBM Perception Sequencer Control

C View group Click the following buttons to change the units displayed in
the Pulse group, the Channel options pane including the CTl value and the
ms/div as well as the x-annotation bar.

View 2

©)ag2s)=]

Figure 5.4: View group

* Time

Click Time to display pulse information in seconds

Cycles (cycles and degrees)

Click cycles to display pulse information in units of degrees, where one
cycle is 360 degrees

Half Cycles (half cycles and degrees)
Click half cycles to display pulse information in units of degrees, where
one cycle is 180 degrees

Click the following button to activate the Pulse Parameter entry bar:

* Pulse Parameter Entry Bar View or hide the Pulse Parameter
Entry Bar. For further information see "The Parameter entry bar" on
page 33.

D Pulse group

. Pulse (cycdeg) A
Channel: Pulse:
Ch 29 &l 00 @

New pulse at cursor

Figure 5.5: Pulse group
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From the pulse group you can change the characteristics of a pulse, delete
or create a new one. Click New pulse at cursor to insert a pulse in the
highlighted channel starting from the CTI handle. Click the arrows in
Channel, Pulse or Start to increase or decrease the value in that field.
Click the drop down box Length to choose the length of a pulse, either a
short Pulse or a pulse that stretches to the end of the sequence (To end).
In all boxes you may enter a value manually using the keyboard. Click
Delete to remove the selected pulse.

Status details group

Status details 2

Figure 5.6: Status details group

To change this information point to the menu bar Sequencer >
Sequence...> Sequence and Synchronization tab in the dialog box. In
the Status details group next to the Main delay there is a button which
will reset the main delay when clicked.

User Keys group group can be used to configure User Keys (see
Perception User manual).

User Keys in general and Sequencer specific (see Perception User Keys
and Macros User manual).

User Keys are described in the appendix “Sequencer User Key Actions”
on page 57.

.Userl(evs ~
+ =
)~
.
a b

Figure 5.7: User Keys group
a [*] Add new User Key
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b = Remove User Key

Clicking the right mouse button on the User Keys group shows following
context menu.

Add new user key...

Delete user key

Setup...

Figure 5.8: User Keys context menu

Figure 5.9 shows the layout of the User Keys group when several User
Keys are added.

Figure 5.9: User Keys added
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G CTI (Current time indicator) value Displays the position of the cursor:

0000:000

Figure 5.10: Cursor value (Detail)

Embedded in this control are additional features. Double click this control
to enable manual input of the CTI value.

H CTI handle Click and drag this control field to adjust the position of the

CTI.

Initially the CTI handle B is located in the top left hand corner of the
display. Use the handle to drag the CTl into the display area. The CTl value
will be shown in the top left corner of the sheet.

B

@ Sequencer | l
0000000 50 cycles/div
* 3 ‘ @ Name E
v |
v [v] O
< v .
v v O
v EY: .

Figure 5.11: Sequencer sheet (Detail)

A CTl value
B CTIl handle

A02702_01_E00_03 HBM: public



HBM Perception Sequencer Control

5.3 Output channel selection and modification
At startup the topmost output channel is selected. This active line is shown by
means of an inverted text line channel number and name. There are several
ways to move around the various channels and modify them:

e Pulse group in the task pane
e Parameter entry bar
e Mouse

For the Pulse group please refer to the section “Using the Sequencer Option”
Figure 5.5 on page 29.

5.3.1  The Parameter entry bar

To activate click the Parameter entry bar button [==Jin the view group in the task
pane.

Note The parameter entry bar appears one line blow the active line.

(2)(x] stat 0000000 | (WL +0050:000 | Length 0000000 P DD
[ ] [ ] [ ] L ) [ ) [ )
!

W — —— J——r—

A B C D E C

n—-=
G ——k

Figure 5.12: Parameter entry bar

A The Up/Down keys are used to move the parameter bar between
channels.

B Start: The readout and manual input of the X-position of a trigger.
C Controls to increase or decrease the X-position of triggers

Click to increase or decrease in the smallest available increments:

[0

Click to increase or decrease in larger increments:

[«)»]

Click this button to increase the start position of a trigger by 0050:000.
Length: The readout and manual input of the length/on-state of a trigger.
The Pulse number displays which pulse is selected in a channel.

G M m O

The Close button to remove the parameter entry bar

A02702_01_E00_03 HBM: public 33
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5.3.2 Mouse control

Mouse dragging is another way to manipulate the pulse dimensions
or on states. Activate a pulse by clicking on it once and it will
highlight.

On mouse hover you will see the double arrow symbol.

If you now select the pulse along the length of the pulse you will
see a selection box appear

To change the length of the pulse you can click on the ends of the
pulse to drag it in either direction.
e Beginning of Pulse. See figure (A)

W -ooos000 H
|

A

I —
|-
B i

e End of Pulse. See figure (B)

B

When dragging, the start and length values of the selected On-state are
continuously updated to reflect the actual position.

At any time when dragging: select the Esc key on your keyboard to cancel the
operation.

The software allows you to create overlap between two (or more) On-states.
This overlap is not visible on the display however. The Sequencer itself accepts
this situation and will use the start and end time of the complete area. Therefore
it is possible to create more On-states than you can distinguish at first glance
on the screen. An easy way to verify is stepping through the various states by
means of the left/right arrow keys.

A02702_01_E00_03 HBM: public
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5.4.1

5.4.2

A02702_01_E00_03 HBM: public

Programming considerations

Create a sequence
To create a sequence a number of steps have to be taken. This section
describes the flow of operations required to set up a sequence.

Load a default sequence
To make a fresh start, select New Sequence or Load Sequence... from the
Sequencer menu.

If you have already defined and saved a sequence with settings which you
would like to use again, click Load Sequence... from the Sequencer menu and
then immediately after click Save Sequence as... from the Sequencer menu
to save this sequence with a new name. This is to prevent accidental changes
in the sequence you have already created. In general: save your work often to
prevent loss of data and time.

Sequence and synchronization

In general the first thing you should do is the definition of the sequence
parameters. Select Sequencer in the menu bar in then select Sequence... the
Sequence Setup window comes up. Here you can define the Duration of the
Sequence and set the Main delay.

Sequence Setup @
Sequence and synchronization | Repetitive testing
Frequency
Nominal frequency 50.00 Hz
Maximum deviation: 4.00
Sequence
Duration: 1000:000 cycdeg  20000.0 ms
Main delay 0 deg 0.0 ms
Synchronization
Input: iGenl (clock+zero) v|
Mode: [ Ful |
Synchronization time: 10000 cyc:deg
Clocks per cycle 180 1]
ok ) (o

Figure 5.13: Sequence and Synchronization dialog
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5.4.3

A Nominal frequency must be filled in to reflect the actual situation. These
numbers are used for verification of the synchronization source and for
conversion between time and cycles. The error in the signal is defined using
Maximum Deviation.

Sequence parameters can be changed for the duration of a test sequence in
cycles and degrees and for the Main Delay in degrees, both are shown in ms.

Settings for the type of Synchronization can also be changed. The input can be
a mains signal or generated. The Mode can be switched between Full,
Timed (a set time), Measured (continuous) or None. Synchronization time is
only available in Timed mode and Clocks per cycle is available in all except
None mode.

Timed Synchronization indicator
When timed synchronization is selected:

2H8.0

A small yellow clock icon is displayed above the display area. This icon
indicates what the active Synchronization time is. You can drag this icon
along the x-annotation bar to change the Synchronization time. A double click
on this indicator will call up the Sequence and synchronization setup dialog
window.

Repetitive testing/Fast Repeat

If you want to add a shift in your main delay between multiple tests you can do
that here along with the option to enable fast repeating for endurance testing.
You may choose shifts in set steps or randomized shifting which is used for a
more accurate statistical representation of results.

A02702_01_E00_03 HBM: public
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A02702_01_E00_03 HBM: public

Sequence Setup @

| Sequence and synchronization | Repetitive testing |

| Enable shift between tests
Addtional shift between the tests:

@ Random between zero degrees and: 1 deg

Fixed shift of 1 degreesin: 1 steps

|| Clear after 1 tests
Fast repeat

/| Enable fast repeat Count: -I_El_

OK Cancel

Figure 5.14: Repetitive testing dialog

First click the check box to Enable the shift between tests mode.

Although each test uses the same sequence, you can make small modifications
to each test by using a Random or Fixed shift for each sequence.

Firstly select enable shift between tests.

e When Random is selected, the main delay will be a random value between
and including 0 and the set value (integer degrees).

e When fixed shift is selected, the shift delay is incremented each time with
degrees/steps degrees. E.g. 180 degrees in 10 steps yields 18 degrees
increments per test

Set up output channels

Once the overall sequence parameters have been set up, each specific output
channel must be configured. To do this click Output... in the Sequencer menu
or double-click on the name of a specific channel. Now the Output configuration
window comes up.
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Note

Output
Output: 1 =
Configuration
Disable output
Name: Ch1
Link to: -|
Link type Q) Full ink per pulse
Pulse start only
Start comection: 0.0 ms

End comection: 0.0 ms

Color: v I ~

Figure 5.15: Output dialog

The Output configuration window comes up with the currently selected output
channel. You can type in another channel name or use the arrows to step
through the available channels.

Each channel has a descriptive name. Type this name in the Name entry field.

Click Disable output to remove the complete selected line from the active
sequence.

When you want to link a channel to another channel with the Full link per
pulse option checked, all program settings (except for output correction) of the
second channel are dynamically copied to the first channel. When you program
the second channel, the settings are automatically copied to the first channel.
E.g. when you link channel 2 to channel 1, channel 2 will use the settings of
channel 1.

When you select the Pulse start only link option, only the start of each On-
state is linked.

You cannot link multiple channels to the same channel. To link multiple
channels to each other you must chain link them, e.g. link channel 3 to channel
2 and channel 2 to channel 1. Any program change in channel 1 will now
automatically be copied to channel 2 and 3.
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To change the start and end points of the linked pulse you should modify the
Start correction and End correction times. The linked pulse will then adjust
its start and end time according to the values in the entry fields.

Output
Output
Configuration
Disable output
Name Ch22
Link to Ch23 >4

Link type @ Full ink per pulse

Pulse start only

Start comection: 100.0

End comection

O
Q
o
8
i o o o o o o o o [

Figure 5.16: Output correction
The maximum Start or End correction is 100ms

Program the sequence

Once the main sequence parameters have been set up and all output channels
to be used are configured you can start to program the Sequencer. For each
output channel you can define the start and the length of the active period by
using the parameter entry bar as described in "The Parameter entry bar" on
page 33.

Download the sequence

There are no special requirements to download the sequence. When the
BE3200 is connected to the PC and on-line, all settings are automatically
updated in the BE3200.

To make contact with the BE3200 from Sequencer you must select the connect

“u
button W in the Status window. When a connection is made the status indicator
changes from Off line to Stand by, the Run button will become active and you
may run your sequence.

The frequency display in the status window shows the actual measured
frequency of the selected synchronization source.
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Start the sequence
To start the sequence, click Run in the status window.

Note When the key-switch on the front of the BE3200 unit is set to Hardware, the run
button in the status window will change to a key-button <&. Meaning the
sequence cannot be started by software control.

Setting the sequence start conditions
In the Menu bar Select Sequencer » Conditions... the dialog Input
Conditions will appear.
Input Qualifier settings
These are Input conditions which must be met before the sequence can be
activated. Each row of boxes is called a Pattern for which the legend is given
below.
Input Conditions @
Am input: Not used |
Input qualifier settings
1 16
Pattem 1: ] Use pattem 1
OR
Paitem 2: Use pattem 2
OR
Pattem 3: | (=] =] | [&][&E | [ Use pattem 3
OR
Pattem 4: 1] | ] == 7] Use pattem 4
| Clear all | Set all | lgnore all
Legend fkey)
[¥] Active ON set) [=] Dont care (gnore)
] Active OFF (dear) _OK—l P
Figure 5.17: Input Conditions

Note The Legend shows what state is selected for each box. Click repeatedly to cycle
through the Active ON, Active Off and Don t care states. Don t care simply
means you do not have an input state with a meaningful value here.

There are 4 available patterns that can be pre defined, selected use of each
Pattern is decided with the check boxes Use pattern 1,2,3 or 4, an active
Pattern has a checked box next to it.
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Carefully select the correct pattern for your needs. Running from left to right are
the conditions which must be met. For example pattern 1 shows:

Input qualifier settings
1 16
Paitem 1: |V|l|V||H Y EE §EE V| Use pattem 1
OR
Pattem 2: ][] | Use pattem 2

Figure 5.18: Input qualifier

The figure 5.10 displays the following logic rule:
IF 1 AND 3 AND NOT 5 AND NOT 7 AND 10 AND NOT 16 are true THEN send
signal “OK to start”

To select or deselect all boxes at once click either Clear all (Off), Set all (On),
or Ignore all (Don'’t’ care).

As an additional safety measure there is also an Arm input condition which
when selected has to be met inclusively with the Input qualifier settings.
Select between High enables start (a high signal) or Low enables start (a low
signal) or Not used to ignore.

As long as the arm condition is met, a start command may be issued and will
be accepted. When the arm condition is false, all start commands, hardware
and software, will generate an error message.

Software repeat (Timer for conditional start stop)

The repeat mode Timer for conditional start stop (in the Control menu)
precedes repetitive testing in Sequencer and is computer controlled, i.e. each
start of the sequence is initiated by computer command. It is generally used for
Automation processes over a longer period of time.
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Timer for Conditional Start Stop
/| Enable
Conditional start
V| Use condtional start
Specified date 15/03/2012
@ Every day at 17:40:31 |
Conditional stop
V| Use condtional stop
Stop  |00:00:30 after start
Specified date
@ Every day at 17:45:31 al
Automatic restart
V| Use automatic restart
Unlimted
@ Number of restarts: 1
Start 01:00:00 (5|~ after (@ previous start
previous stop
OK || Cancel || Apply |
Figure 5.19: Timer for conditional start stop
Click the check box to Enable this section and then activate each separate
condition with the corresponding check box. The Use Automatic restart option
will run a number of test restarts at a chosen Start time after the previous
start or previous stop time.
In addition to this computer controlled repeat the Fast Repeat is available.
Refer to "Repetitive testing/Fast Repeat" on page 36 for further details. When
this selection is checked the sequence will be repeated the selected number of
times without computer control. This repeat count resides within the test
Sequencer and once enabled becomes an integral part of the sequence.
The start of the next sequence is almost equal to the end of the previous
sequence. There is a small delay between the two consecutive sequences. See
also the specifications. The two repeat modes can be combined as shown in
the following diagram:
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1 3 |
i‘ Delay between tests g
12134 1{2]|34 R
time
2 » 1.5Sec | i T3 Sec
112 E Delay between tests E T )
| | I time
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Figure 5.20: Repeat mode diagram

Diagram 1 shows the following situation:
Sequence duration 1,2,3,4 = 0.5 seconds
Fast repeat count =4
Delay between tests = 4 seconds

Diagram 2 shows the following situation:
Sequence duration = 0.5 seconds
Fast repeat count = 2
Delay between tests = 4 seconds

As shown in Figure 5.20 the minimum duration of a test is 1.5 seconds.
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5.5 Sequencer data sources
For configured pulses information of a pulse is available as data sources. See
Perception User Manual for details on data sources. The information is listed
under category Sequencer in the Data Source Navigator. Following information
for each configured pulse is available.
Data Sources X
a8 Name A
= Pulse001
e Lengthe——— B
e Start (o]
-4 pulsenoz
e Length
e, Start
-5 pulse003
e Length
e, Start
23 PulseCount D
#-f5] Chooz
+-f=] Ch0o3
+ ﬁ Choos
-8 system
Figure 5.21: Sequencer data sources in the Data Sources Navigator
A Name of the channel to which the pulse belongs
B Length of each pulse
C Start of each pulse
D PulseCount Number of configured pulses for each channel
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5.6 Configure Sequencer sheet layout
In the Sequencer main menu several menu items can be found which can be
used to configure the Sequencer sheet layout.

5.6.1 Layout

When menu item Layout is selected the dialogue in Figure 5.23 is shown.

Seguencer

[CTIRTS

New Sequence...

Load Sequence...

Save Sequence As..,
Sequence...

Output...

Conditions...

Hardware...

Layout...

Channel Display Height
Time Scale

User Table

Print Sequence Report...
Print Sequence Settings...
Options...

Move Sheet 'Sequencer’ to

Read only

Figure 5.22: Main menu item Layout

A Layout opiton

A02702_01_E00_03 HBM: public
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In Figure 5.23 the width of the channel name fields and the font size of the

channel names can be set. Also the channels which should be shown on the
Sequencer sheet can be selected.
Channels can be moved to different positions with the blue arrows and can be
deactivated by deselecting the check boxes. By default only the first 64 output
channels are active.

Layout
Channels name layout
A ———= Ficld width: 66 =

B ——sFortsize: |78

Channels selection

Select the channels that you want to use. Use the Up and
Down amow buttons to re-arange the order within the list.

2
%]
m| »

OK || CcCancel |

[ Selectall |

Figure 5.23: Layout dialog

OO0 w >

m

Field width To set the width of a channel.
Font size To set the font size of a channel.
Channels Select which channels should be shown.

Check box To remove a channel from the display clear it's corresponding

check box.

Check box To add a channel to the display select it's corresponding check

box.

Up and down arrows To move a channel up or down, click the blue up or

down arrows.
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5.6.2 Channel display height
Menu item Channel Display Height can be used to set the height of a channel
in the display area. Following heights are possible:

Seguencer i
New Sequence...

Load Sequence...

WLy e

Save Sequence As...
Seguence...
Output...
Conditions...
Hardware...

Layout...

Channel Display Height » Small

-—
Time Scale *» | @ Medum ——B
User Table 4 Large —

-

Print Sequence Report... Auto

Print Sequence Settings...

=Ty

Options...
Move Sheet 'Sequencer' to »

Read only

Figure 5.24: Main menu item Channel Display Height

A

B
Cc
D
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Small Default selection
Medium 2 * Small
Large 4 * Small

Auto The height of the channels are adjusted to fill the available space in
the display area (Small height < Auto height < Large height)
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Examples of Channel Display Height settings:
.:Hl)uno_New,pMAPerupﬁunEPrimw) = ‘3‘
File Edit Control Automation Seguencer Window Sheets Help
DB HdE @ 4 = B & &=
£ Sequencer
_;_, |05 Sl R A e R R A )
@ Status 4 o : 5 )
5 N System o4
; :
E Frequency:
E Progress [
g Cantrol
Acquisition Status: | Tdle | Active Recording: | Mone | User Mode: | Continuous | @ |
Figure 5.25: Channel Display Height set to Small
D e W Pesteption Prony = a'“
Eile Edit Control Automation Seguencer Window Sheets Help
PORBEEHE @ & e B & s8R
_‘ £ Sequencer
P |20 IR ) 0 O  TO0D0.01 B T I 200000
g [ St # e = Ch | Name 3
g System 2 - X
::: Frequency: )
— J
g I“\'-K Aun =
Active Recording: | None | User Mode: | Continuous | @ |
Figure 5.26: Channel Display Height set to Large
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User Table

Menu item User Table can be used to add a User Table to the Sequencer sheet.

See Perception User Manual for details on User Tables. Following options are
possible:

2
c
m
=
N
m
=

—

Mew Sequence...

Load Sequence...

o e

Save Sequence As...
Seguence...
Output...
Conditions...
Hardware...
Layout...

Channel Display Height 3

Time Scale 3

User Table » Hide e—on—— A
!i‘.:l Print Sequence Report... ® Show Bottom B
@ Print Sequence Settings... Show Righte——— C
iz Options...

Move Sheet 'Sequencer' to »

Read only

Figure 5.27: Main menu item User Table
A Hide No User Table is shown
B Show Bottom User Table is added at the bottom of the Sequencer sheet

C Show Right User Table is added at the right side of the Sequencer sheet

When a User Table is added the display area is split into two areas. One area
contains the channels and the other area contains the User Table. The area

size can be adjusted by moving the splitter which separates both areas (see
Figure 5.28).
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— haots Hele ..-I.@.
; o 4 = L &
¢ I - 4 =3 o)
P am o i" Channel ) Pulse Start Length
S § : Chi \N/3 12364 1054
1'% : on1 \ N8 36658 18323
i « Ch1 \ O\ 70588  4100.1
e ¢ Ch2
z T ' Ch2
—— = » Ch3
n Ch3
Mempimmons || i , I
— Do ¢
\wnel Pulse Sta/
2/3 I/
Figure 5.28: User Table showing data source information of configured pulses
A Splitter Move the splitter to adjust the channel and User Table area size
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Sequencer Run button vs. Acquisition Start

Introduction
This section describes the implementation of the start/stop interaction between
the Sequencer sheet and the Perception acquisition control.

The Sequencer:
1. After start-up the Sequencer is in Offline mode.

2. Click the Connect button to set the system on-line and download the
currently loaded sequence.

3. Click Run to start the sequence.

4. The Run command is also sent to the acquisition control. However,
this only reaches the acquisition control when the check box include
acquisition (synchronize) is set. If not set, the acquisition is not started
and the sequence runs stand-alone

The acquisition control:
5. Click Start to start the acquisition.

6. The Start button also sends a signal to the Sequencer control.
However, this only reaches the Sequencer control when the Sequencer
hardware is on-line. If not, the sequence is not started and the
acquisition runs stand-alone.
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6.1 Channel Linking

By selecting the drop down boxes under the #2 icon you can choose which
channels pulses link together.

(R  20cycles/diy | J026:00
#* 2 a3 Ch | Mame o
| i

7

0
w| 2 ch2 OrCreE—C

w

v
v v D | _—B

bt o4 }
123 4

5

Figure 6.1: Channel area (Detail)

A

B
Cc

Clickable areas

Activation of a Channel, on or off

Lock Channel to changes

Link setting, full pulse length or start pulse position
Channel to link to, so that pulses move together
Label color

AL ON-

Extendable pulse cursor Partial linking is possible

Locked Channel cursor No editing is possible

In Figure 6.1 Channel 1 is linked to Channel 2 from End-to-End of each pulse
and Channel 2 is linked to Channel 3 only from the start of the pulse, the
clickable icons in 3 show the type of linking used.

" This icon shows partial linking is enabled (linked from the start of a pulse).

= This icon shows full End-to-End linking is enabled.
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Zooming

For an accurate view of switching events you can zoom in on the time scale.
Zooming can be done into the finest detail. Once zoomed, clicking on the star
icon at the bottom of the page will bring you back to full view again.

To zoom drag the cursor: click the left mouse button and while keeping it
pressed drag the mouse cursor to the required position. Release the mouse
button. While dragging, the selected area will be shown on the display as a
greyed out part of the graph area.
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AA1

Where has my...function gone?

In this section we will outline the major changes from the Legacy version of the
software. You may be used to previous software commands and terminology,
this chapter show the most recent commands and terminology changes and

where they are currently located.

Legacy File menu

Dynamic menu (Sequencer)

New... New Sequence...
Open... Load Sequence...
Save Save Sequence
Save As... Save Sequence As...
Print Report... Print Report...
Print Settings... Print Settings..
Exit N/A

Recently Used File List N/A

Legacy Edit menu

Copy N/A

Paste N/A
Preferences... Options...

Legacy View menu

Dynamic menu

Time Time Scale » Seconds
Cycles Time Scale » Cycles
Halfcycles Time Scale » Halfcycles
Page » N/A (removed page concept)
Page Setup... Layout...

Legacy Setup menu

Dynamic menu

Synchronization... Sequence...
Conditions... Conditions...
Output... Output...
Sequence... Sequence...
Repeat... Sequence...
Step Size... Options...
Hardware... Hardware...
Test... Hardware...
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Control menu

Online

N/A

Start Sequence

N/A

Enable Channel

N/A (moved to annotation area)

Additional Changes

Endurance testing

Repetitive testing

Main Delay Shift
Speed bar Removed
Start button Run button

Synchronization Input

Gen1,Gen 2 (clock and zero/ zero),
mains

Synchronization sources

No internal - 2 different types for

generators

Status bar

|21-Oct-2008

16:05||

Main Delay: 0 degress || Repeat disabled

|| Sync: Gen1 (clock and zero)/Full |
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B o

Figure A.1: Status bar in Legacy

Status bar

A Shows the date and time by default.
When the cursor is in the graph area it
displays the position of the cursor.
When a sequence is running it is used
to show the progress of the sequence
in the form of a bar graph

The date and time have now been
removed/hidden.

B Displays the main delay. A right
mouse click in this tray will call up the
Sequence Setup dialog window.

This has been moved, it is now the first
object in the status group.

C Reflects the Repeat count. When a
sequence is running it will show the
count number and the total repeat
number. A right mouse click in this tray
will call up the Repetitive Test dialog

window.

This has been moved into the menu
bar and can be set by navigating to:
Sequencer > Sequence > click
Repeat testing.
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Status bar

D Shows the synchronization mode.
When a sequence is running it will
display a warning when the
synchronization is lost. A right mouse
click in this tray will call up the
Synchronization Setup dialog window.

This has been moved to the status
group.
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B Sequencer User Key Actions

B.1

Note
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Introduction

The Sequencer sheet comes with predefined User Key Actions. The
Sequencer User Keys actions can make it easier to manipulate the position and
size of a Sequencer pulse.

For more information about User Keys (general), please refer to the
A05025 01_EO00 _00 Perception User Keys and Macros User manual.

In this chapter the various Sequencer User Keys are described.

Sequencer User Key actions
Decrease pulse length
Increase pulse length
Disable Sequencer channel
Enable Sequencer channel
Lock Sequencer channel
Unlock Sequencer channel
Move pulse start backward
Move pulse start forward

9 Set pulse as active pulse

10 Set pulse length
11 Set pulse start

O ~NOOOA R OWON-
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B.1.1  Decrease pulse length
""I_I"" Decrease the length of a Sequencer pulse in the Set Decrease pulse
*1 1% length dialog.
Source
A ———= @ Channel: Event 1 +| Pulse: 11 =
B —— O ActivePulse
Step size
C —— @® Time (ms) 100.0 2
D —— O Cycles 0001:000 =
E ——— (O Half Cycles 1.00 2
Corc
Figure B.1: Set Decrease pulse length
In this dialog you can define if the pulse to be modified should be a predefined
pulse of a Channel (A) or if the pulse should be the Active Pulse (B) in the
Sequencer sheet.
The step size to decrease the pulse length can be defined in Time (A), Cycles
(B) or Half Cycles (C).
B.1.2  Increase pulse length
H Increase the length of a Sequencer pulse.
* = I For more information, please see Decrease pulse length.
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B.1.3

B.1.4

B.1.5

B.1.6

B.1.7

B.1.8
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Disable Sequencer channel

Disable a Sequencer channel in the Configure 'Disable sequencer
channel’ dialog.

Configure 'Disable sequencer channel' X

Source
A ——O Channel: Ch 1 .
B ———e@® Active channel

=

Figure B.2: Disable Sequencer channel

The Channel (A) to be disabled can be a specific pre-defined channel or the
Active Channel (B).

Enable Sequencer channel

For more information, please see Disable Sequencer channel.

Lock Sequencer channel

@ Lock a Sequencer channel.
The configuration is similar to Disable Sequencer channel.

Unlock Sequencer channel

El Unlock a Sequencer channel.
The configuration is similar to Disable Sequencer channel.

Move pulse start backward

I_I"'_"' Move the start of a Sequencer pulse backwards.
* = ! For more information, please see Decrease pulse length.

Move pulse start forward

"'I__—I.: Move the start of a Sequencer pulse forwards.
* 1'% For more information, please see Decrease pulse length.
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B.1.9

B.1.10

B.1.11

Set pulse as active pulse

Set a pulse as the active Pulse (A) in the Sequencer sheet in the Set
active pulse dialog.

Set active pulse X

Source Iy B
A ———= Channel: Event 1 2 Pulse: 1/ =

=

Figure B.3: Set active pulse

Use the configuration dialog to select the Channel (A) and Pulse (B) to be set
active.

Set pulse length

I+ Set the length of a pulse.
For more information, please see Decrease pulse length.

Set pulse start

I—=_ Sets the start position of a pulse.
I I For more information, please see Decrease pulse length.
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